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Warranty Information
Your IOtech warranty is as stated on the product warranty card.  You may contact IOtech by phone,
fax machine, or e-mail in regard to warranty-related issues.

Phone: (440) 439-4091,  fax:  (440) 439-4093,  e-mail: sales@iotech.com

Limitation of Liability
IOtech, Inc. cannot be held liable for any damages resulting from the use or misuse of this product.

Copyright, Trademark, and Licensing Notice
All IOtech documentation, software, and hardware are copyright with all rights reserved.  No part of this product may be
copied, reproduced or transmitted by any mechanical, photographic, electronic, or other method without IOtech’s prior written
consent.  IOtech product names are trademarked; other product names, as applicable, are trademarks of their respective
holders.  All supplied IOtech software (including miscellaneous support files, drivers, and sample programs) may only be used
on one installation.  You may make archival backup copies.

FCC Statement
IOtech devices emit radio frequency energy in levels compliant with Federal Communications Commission rules (Part 15)
for Class A devices.  If necessary, refer to the FCC booklet How To Identify and Resolve Radio-TV Interference Problems
(stock # 004-000-00345-4) which is available from the U.S. Government Printing Office, Washington, D.C.  20402.

CE Notice
Many IOtech products carry the CE marker indicating they comply with the safety and emissions standards of the
European Community.  As applicable, we ship these products with a Declaration of Conformity stating which
specifications and operating conditions apply.

Warnings, Cautions, Notes, and Tips
Refer all service to qualified personnel.  This warns of possible personal injury or equipment damage under noted
conditions.  Follow all safety standards of professional practice and the recommendations in this manual.  Using this
equipment in ways other than described in this manual can present serious safety hazards or cause equipment damage.

This warning symbol is used in this manual or on the equipment to warn of possible injury or death from electrical
shock under noted conditions.

Use proper ESD handling guidelines when handling equipment or components sensitive to damage from electrostatic
discharge.  Proper handling guidelines include the use of grounded anti-static mats and wrist straps, ESD-protective bags
and cartons, and related procedures.

This symbol indicates the message is important, but is not of a Warning or Caution category.  These notes can be of
great benefit to the user, and should be read.

In this manual, the book symbol always precedes the words “Reference Note.”  This type of note identifies the location
of additional information that may prove helpful.  References may be made to other chapters or other documentation.

Tips provide advice that may save time during a procedure, or help to clarify an issue.  Tips may include additional
reference.

Specifications and Calibration
Specifications are subject to change without notice.  Significant changes will be addressed in an addendum or revision to the
manual.  As applicable, IOtech calibrates its hardware to published specifications.  Periodic hardware calibration is not covered
under the warranty and must be performed by qualified personnel as specified in this manual.  Improper calibration procedures
may void the warranty.

Quality Notice
IOtech has maintained ISO 9001 certification since 1996.  Prior to shipment, we thoroughly test our products and review
our documentation to assure the highest quality in all aspects.  In a spirit of continuous improvement, IOtech welcomes
your suggestions.
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Introduction 1
What is eZ-NDT/RI …… 1
System Requirements …… 2
Order of Operation …… 3

Reference Note:
If necessary, refer to the ZonicBook Getting Started User’s Manual for information
regarding the following:

➣ Software Installation

➣ System Requirements

➣ Hardware Setup

➣ Driver Installation

What is eZ-NDT/RI?
eZ-NDT/RI is a non-destructive QA / QC inspection system based on the ZonicBook FFT.  High frequency
vibration data is collected and compared against user-defined amplitude and frequency limits.
A passed (good) part will have the maximum spectral peak(s) within the defined limit band(s).
A failed (bad) part will have one or more spectral peaks outside the defined limit band(s).

The minimum eZ-NDT/RI system includes a computer running a Microsoft windows operating system,
a 2-channel ZonicBook FFT Analyzer, one modal hammer, and one microphone.  The hammer is attached
to Channel 1 of the ZonicBook and the Microphone is attached to Channel 2.

Preparing for QA / QC inspection requires an iterative process of testing known “good” and “bad” parts.
First at least one known “good” part (preferably 10) is tested in the investigative mode.  Then known “bad”
parts are tested (preferably at least one of each defect type).  The vibration data of the “bad” tests are then
compared to the “good” tests.  At this time limit bands are defined based on vibration peaks that occur in
the “good” test that do not appear in the “bad” tests.  After up to 10 limits are defined all the parts are tested
to insure that all the “good” parts pass and all the “bad” parts fail.  Some fine-tuning may have to be done.
Because this process detects internal, non visible, defects you may have an occasional “good” part fail.
When the results of the testing are consistent, you are ready to start testing production parts in the
QA Mode.

When an automated system is used, there are other process considerations that need
to be addressed and configured.  These are typically addressed at the factory prior to
shipment.

Multiple user levels exist for your protection.  Level 3 is for the manager and allows complete access to the
System.  Level 2 is for the technician and Level 1 is for the inspector.  Levels 1 and 2 do not permit
configuration modifications, among other limitations.

The first time eZ-NDT/RI is executed, it will automatically load the default configuration parameters into
the “Project Template”.  The Project Template is located in the Windows directory where you installed
eZ-NDT/RI.  You should consider an “eZ-NDT/RI Project” equal to a unique Part that you wish to test.

For example, if you manufacture Widgets and Gizmos, you would have 2 separate eZ-NDT/RI projects,
one for Widgets and one for Gizmos. Each eZ-NDT/RI project is saved in one project file with the
extension “.ndt”—so, the widget project in the previous example might be named “widget.ndt”, and the
gizmo project might be named “gizmo.ndt”.

Each eZ-NDT/RI project is saved in one project file with the extension “.ndt.”
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System Requirements
Minimum computer requirements include:
• Intel™ Pentium® PC 90 MHz, or equivalent
• 32 MB memory
• 50 MB free disk space
• Windows 9x/Me/NT4.0/2000/XP operating system
• ZonicBook FFT Analyzer, impact hammer, microphone, cables.



ZonicBook 10-30-01 eZ-NDT/RI, pg.  3

Order of Operation
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Investigative Mode Testing 2
1. Gather known “good” and “bad” parts …… 5
2. Set up the analyzer, hammer, microphone, and computer …… 5
3. Launch eZ-NDT/RI …… 6
4. Open a New eZ-NDT/RI Project …… 6
5. Select Investigation Mode …… 7
6. Configure the ZonicBook …… 7
7. Select Plot Display Type …… 8
8. Turn on Data Acquisition …… 8
9. Test All Good Parts …… 8
10. Test All Bad Parts …… 10
11. Compare the Results of Good and Bad Tests …… 10
12. Configure the Limits …… 10
13. Verifying the Limits and Ranges …… 12

The following process can be used to determine whether eZ-NDT/RI testing is feasible for the part that is
being tested.  Typically this is an iterative process, where you establish the resonant signature of the part
and determine the distinct peaks of the signature.  These peaks are then used to set up the test criteria that
eZ-NDT/RI will use.  During this process, as well as during production, it is very important that you strike
each part at a consistent location and with a consistent amount of force.

1. Gather known “good” and “bad” parts.
Locate both good and bad parts.  Typically 10 of each are sufficient.  Make sure the Bad parts include all
possible reject (failure) modes.  The good parts will be used to test for NDT/RI testing feasibility.

Block Diagram of Typical NDT/RI Setup
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2. Set up the analyzer, hammer, microphone, and computer.
Connect your analog input signals to the ZonicBook’s BNC inputs. Configure the ZonicBook as needed.

Reference Note:
If necessary, refer to the ZonicBook Getting Started User’s Manual for information
regarding the following:

➣ Software Installation

➣ System Requirements

➣ Hardware Setup

➣ Driver Installation

a. Connect the Impact Hammer to Channel 1.

b. Connect the Microphone to Channel 2.

c. Place the microphone within range of the output.

3. Launch eZ-NDT/RI.
To run eZ-NDT/RI, double-click the eZ-NDT/RI icon or use your Windows desktop Start button to
navigate to the program file.

First Time Running eZ-NDT/RI

Registration Form

Note:  After you have completed the following steps, each succeeding time that you start eZ-NDT/RI you
will be taken immediately to the main screen.

A registration form will open the first time you run eZ-NDT/RI.  You must complete the information in this
form to enable the eZ-NDT/RI application.

The password accompanies your CD-ROM.  You will not have to re-enter this information again, unless
you upgrade to a newer version, or have to re-install eZ-NDT/RI.

eZ-NDT/RI will open to its main screen, as shown below.

eZ-NDT/RI Main Window
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4. Open a New eZ-NDT/RI Project.
Each eZ-NDT/RI Project contains configuration and data files.  You should logically equate an eZ-NDT/RI
project with a specific part that you wish to inspect.

Because multiple eZ-NDT/RI Projects will exist on your computer we suggest you create project
folders to organize and save your files.  These folders can be located anywhere on your system.

a. On the File menu select New Project to open the “Save As” window.

b. Select a folder for your eZ-NDT/RI Project or create a new folder.

Save As Dialog

If you created a new folder...

With “New Folder” highlighted, type a name for the Project Folder. Then, double-click on the folder to
open it.  This is where you will save your new project files.

c. Type a filename for the project, including the file extension, in the File name data entry box.
 i.e.  part234.ndt

NDT.ndt is the default template.  DO NOT use that filename.

d. Click the Save button to create the new project.  Now all the files for this project will be saved in the
folder you just used.

5. Select Investigation Mode.
On the main screen select Investigation Mode.

6. Configure the ZonicBook.
To start use the default values.

If you have tested both good and bad parts, and you do not see a difference between them,
you may need to modify one or more of the configuration values.
Increasing the Trigger Delay is the most common solution.
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7. Select Plot Display Type.

The plot display types are selected by clicking on one of the above two icons.  The one on the left is a time
wave display and the one on the right is a spectrum display.  Click on the Spectrum icon.

8. Turn on Data Acquisition.
Click the Red toggle switch in the Acquisition panel of the Main window.  This will initialize the
ZonicBook.  Wait for the Ready status.

9. Test All Good Parts.

Parts Panel

Select the Good Part radio button.

Strike the parts several times at a consistent location with a consistent amount of force.  It is likely that the
part will indicate “FAIL”  because limit bands have not been set.
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If you do not see anything on your plot,  click on the <Autoscale> button,  ,

or the <lin/log> button,  to expand the y-axis.

Using the logarithmic scale tends to enhance the peaks making it easier determine relevant
and significant peaks.

Linear Scale of Initial Strike

b. Click the Autoscale Icon, , to have the Y axis minimum and maximum scaled to the data.

Autoscale of Initial Strike
(Logarithmic Scale)
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10. Test All Bad Parts.

Parts Panel

a.  Select Bad Part.

b.  Select the number of bad parts you intend to test at this time on the Test Parts menu.

c.  Test the bad parts in the same manner used in Step 8 above.

11. Compare the Results of Good and Bad Tests.
Visually locate the spectral differences between the Good Part (Blue Line) and Bad Parts (Red Lines).
You are looking for resonant peak(s) that shift in frequency (red lines to the left or right of the blue line)
and/or amplitude (red lines shorter or taller than the blue line).  If blue and red peaks are almost identical,
they are probably not good choices.  Ideally you will find significant single peaks.

Because this process detects internal, non visible defects, you may have an occasional
“good” part fail.

12. Configure the Limits.
Modify the limit bands to match the “Good” part’s spectral peaks that you want to use. As mentioned
earlier, this is an iterative process.  Quite often not all your “Good” parts will pass with these exact limits
the first time.

There are four limit bands already placed on the plot.  These limit bands are green acceptance limits—
peaks for subsequently tested parts must be within these limits to be counted as “Good” parts.  Working
from left to right, drag the first band to the first peak you want to use.  Next, drag the second band to the
second peak you want to use.

If you do not need all four of the limit bands, delete the extra bands.

To delete a Limit Band, right-click on the Limit button, select Delete Limit.

Limit
Buttons

Status Panel

If you need more limit bands you can add up to a total of 10.
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To add a Limit Band, right-click on the Channel button, select Add Limit.

Channel
Button

Status Panel

Right-click on the Channel
and select add Limits

The new Limit Band is
always added in the middle
of the plot

Adding a new Limit Band
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13. Verifying the Limits and Ranges.
a. Switch to QA Mode.

b. Test all the known “Good” and “Bad” parts.  You are looking for consistent results.
Do they pass and fail as expected?

• If yes you are ready to go to production.

Click the Save Limits Icon, .

• If no, answer the following questions.
-- Are any peaks just a little bit out of range?  Modify those limit bands a little.
-- Are there peaks that you missed the first time?  Add a limit band.
-- Are there two peaks that are fairly close, one within the band and one not?

Sometimes you will have 2 closely spaced peaks.  These peaks will “fight” for dominance.

You can either remove that entire range, widen the range to include both peaks, or split the range
with one peak in each range.

c. Re-test the “Bad” parts.

Did all the Parts FAIL?

If no, you need to go consider setting amplitude limits. Sometimes, the only difference between
a good and bad part is a difference in amplitude of a significant peak.   You can change the amplitude
of a limit band by right-clicking the top or bottom of a limit band and dragging it up or down.

Right-click and
drag the Limit
Band up or down

Changing the Limit Sizes

If you still can’t distinguish between “Good” and Bad parts, try changing the Pre/Post Trigger Delay
Percentage value of the trigger channel.  By increasing this value, you are delaying the start of the sound
measurement.  This delay can be very helpful identifying cracked parts, because a cracked part can not hold
a tone.  The resonant frequencies of a cracked part die out quickly.
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Q/A Mode Testing 3
1. Launch eZ-NDT/RI …… 13
2. Open the eZ-NDT/RI Project …… 13
3. Turn on Analyzer …… 13
4. Test Parts …… 14
Reviewing NDT/RI Inspection Results …… 14
Preparing Reports …… 15

A feasibility test and setup of the test parameters must be completed prior to starting
production testing.

1. Launch eZ-NDT/RI.
To run eZ-NDT/RI, double-click the eZ-NDT/RI icon or use your Windows desktop Start button to
navigate to the program file.

2. Open the eZ-NDT/RI Project.
Select Open Project on the File Menu.  Find the project of interest and double-click on it.  This will open
the project and set up the test parameters.

3. Turn on Analyzer.
Click the Red toggle switch in the Acquisition panel of the Main window.  This will initialize the
ZonicBook.  Wait for the Ready status.

Acquisition Panel (Off) Acquisition Panel (On)
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4. Test Parts.
If you are using an automated system, start the conveyor and start loading parts onto the conveyor.

If you are using a manual system, strike the part, at the prescribed location, with the hammer.
eZ-NDT/RI performs the inspection process when the “Force” channel’s trigger conditions are met.

After you strike the part, check the Hammer Status message in the Acquisition Panel and the Status Panel.
If your hammer strike resulted in a Trigger, you will see the NDT/RI inspection results, PASS or FAIL.

Note on Performance Speed:  Each part may take from 1-2 seconds to test under Level 3.  For quicker
results switch to Level 1 (graphics are not updated).

Troubleshooting:  If the Trigger did not occur, you need to verify one or more possible causes.

• There is a hardware problem.  Check the trigger channel’s cable connections.  If this instrument
requires ICP verify the ZonicBook Dip Switch settings.

• There is a configuration problem.  Check the trigger channel’s FSV and Trigger Percentage.  The input
trigger voltage may be lower than the configuration settings.  If you are operating at the Technician or
Operator level, you will need to change the User Level to Manager to check and make changes to the
configuration settings.  Clicking the “Reset/Set Default” button will normally correct any problems.

Reviewing NDT/RI Inspection Results
The Summary Panel contains the NDT/RI inspection results since the last time the <Reset Counts> button
was pressed.  The total number of Passed and Failed parts, as well as the consecutive count, are listed.
The Since label shows the last time the <Reset Counts> button was pressed.  The <Reset Counts> button
clears the Passed / Failed / Consecutive / Since labels.  It does not erase the data stored in the history file.
The Last label displays the date and time of the last NDT/RI inspection.

The above information can be removed from the screen by pressing the Review Summary Counts
button, .
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Preparing Reports
After each NDT/RI inspection, the test results are stored in the history file.  This is a FIFO,
“First-In, First-Out”  file.

eZ-NDT/RI is capable of generating three types of reports from this history file: Production, Plot Data,
and Configuration Settings. Select any option for that type of report to be generated. These reports are text
files—after selecting a report type, you will be prompted to enter a filename for the text file using a
standard Windows dialog box. The features of the three report types are as follows:

Production Report – After choosing Production from the Report menu, a production report dialog box
opens. It displays two radio buttons, allowing the user to choose either a Summary or Detailed production
report.

• The Summary report lists the inspection status of each part tested over the selected date and time
range. The serial number and inspector name is also listed.

• The Detailed report, in addition to the information contained in the summary report, also provides the
measured frequency and amplitude peak for each spectral band on a given response channel.

• Both the Summary and the Detailed Report provide a statistical summary at the bottom of the report.
The statistical summary lists the counts, average, and standard deviation values for both Passed and
Failed parts.

To the right of the production report dialog box is a graphic and a sliding scale, which both represent the
amount of data held in the project’s history file. The sliding scale allows the user to choose the amount of
data which will appear in the report. To use the sliding scale:

1. Click on the green start arrow and drag it to the desired starting percentage. The date and time of the
first data point will be displayed at the bottom of the scale.

2. Click on the red end arrow and drag it to the desired ending percentage. The date and time of the
final data point will be displayed at the top of the scale.

3. Click the Okay button.

For example, if you wanted to generate a report using only the last 50% of the history file, you would drag
the green arrow to between “40” and “60” on the scale, and drag the red arrow to “100”. To use the entire
history file, leave the green arrow at “0” and the red arrow at “100”.

Plot Data Report – Choosing Plot Data from the Report menu generates a list of all the data points (using
x and y coordinates) that are displayed on the graph. The units used for the x and y coordinates in the report
will depend on whether the graph was set to the Time display or Spectrum/FRF display.

eZ-NDT/RI can also generate a Configuration Settings report, which lists many of the configuration
options that are set in the ZonicBook Configuration screen (accessible by selecting the Edit menu, and the
ZonicBook...).
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Windows and Menus Section 4
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Main Window

Test specific information is located at the top of the display and includes Company Name, Part Name,
Serial Number, and Inspector Name.  This information is stored with the data after each NDT/RI
inspection.  Company Name and Part Name are set up in the Acquisition Tab of the ZonicBook
Configuration window.

The part’s Serial Number and the Inspector’s Name can be manually entered in the text fields shown.
A picture of the part being tested can be inserted in the top left corner.

Main Window
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eZ-NDT/RI can be operated in two modes.  Q/A Mode is for normal testing and Investigation Mode is for
feasibility testing and Limit Configuration.

Mode Panel

Acquisition Panel

Acquisition Panel

The Acquisition Panel contains the ON/OFF toggle for the analyzer.  It also displays the current date and
time, the Security Level at which it is currently operating, the status of the analyzer, and the number of
averages taken.

Relay Output Panel

Relay Output  Panel

The Automation Panel is used with the optional relay control package.  The toggle switch controls the
ON/OFF status of the eZ-NDT/RI Automation Module.  The Relay Icons indicate the current status of the
relays. Each time you start the NDT software, the Automation main switch is turned off.  You must turn on
this switch to send output to the relay channels.  Relay channels can be either be set to trigger according to
the state of a channel, or they can be triggered manually by clicking on the appropriate Relay Icon.

Display Panel
The Display Panel contains the following display related options.

Display Panel
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Show Cursor Values: Cursor values are only shown on request.  Click the Show Cursor Values Icon to
open a floating display of the cursor values.  Click on the upper left corner of the display to move it
anywhere on the screen.  Values are displayed in the x, y format.

Cursor exists for each defined limit range.  The cursor is automatically positioned to the highest peak in the
limit range.  You can move the cursor by dragging it across the graph with your mouse or by using the
keyboard.  The “4” and “, (comma)” keys move the cursor Left.  The “6” and “. (period)” keys move the
cursor Right

Cursor Values Table

Y-axis Format:  The default is linear, Auto Scale enabled.  To change the format, click

the <Lin / Log>  button,  and the <Auto Scale> button,  Time displays are always linear.  Auto
Scale is either enabled or disabled. When enabled, the Y axis scale is 20% greater than the data range.
When disabled, the Y axis scale is defined by the instrument range in the configuration.

Data Display Formats:  The default display is Spectrum.  To change the format, click the

<Time> button, , or the <Spectrum> button .

Status Panel

Status Panel

The Status Panel includes the overall inspection results as well as the inspection results of each spectral
band for each response channel.  Green indicates “Pass”.  Red indicates “Fail”.  The icons illustrate the
current condition of the output relays (each defined spectral band limits).

Overall Part Status:   The <PASS/FAIL> button is the large button to the left of the <channel> buttons.
On eZ-NDT/RI start-up, this button is  blank.  After each NDT/RI inspection, the button’s color and status
message reflect the inspection results.  Red indicates a failed part.  Green indicates a good part.  Click on
this button to view the entire spectral range.

Channels:  <Channel> buttons are shown vertically from 1 to 8.  Both Force and Response channels can be
displayed in either the Time or Spectrum format.  Unused channels are not enabled (dimmed).

Limit Range Buttons:  The horizontal numbered buttons show the NDT/RI inspection status for the
defined limit ranges.  Red indicates fail.  Green indicates pass.  Up to 10 ranges exist for each response
point.  To display a range of interest, click on the desired <range> button.  To view the full scale, press the
<Overall Part Status (PASS/FAIL)> button. To return to the original X-axis scale, click on the
<Overall Part Status> button again.

Clicking on a <Limit Range> Button expands the graphical display to show that particular Frequency and
Limit Range.
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Summary Panel

Summary Panel

The Summary Panel provides the summary results for the most recent NDT/RI inspections.

<View Summary Counts>:  This toggle button, , is used to  hide and show the
summary counts.

<Reset Summary Counts>:  This button, , resets the summary counts to zero.
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Graphical Display

Limit Range
The Graph displays the results of a strike.  The acceptance limit regions are shaded in green;
failure limit regions are shaded red.

Graph Displaying Three Acceptance Limit Regions

The <Limit> buttons in the Status Panel control the Limit display.  Click on a <Limit> button to show a
specific Limit Range and Limit Band.

      Click to return to full view.

      Click to see Limit Range
       for this Limit Band

       Limit Band

                     Limit Range

Manipulating the Graphical Display
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Modifying Limits from the Main Window.
Add Limit Band: Using your mouse, right click on the channel of interest and select “add a limit.”  The
new limit will be placed in the middle of the frequency range. Move it to the desired location.  See Moving
acceptance area below.

Limits added in this manner will always be green acceptance limits.
To add red failure limits, use the Limits screen of the ZonicBook Configuration Menu
(accessible under the Edit menu by clicking on ZonicBook).

Remove Limit Band: Using your mouse, right click on the spectral band icon you want to remove and
select “delete limit.”

Increase/decrease Limit Band: Using your mouse, right-click on the edge of the green acceptance
 (or red failure) area.  You’ll see a left & right pointing arrow.  While continuing to press the right mouse
button you can drag the edge of the limits across the x-axis.  A small pink box displays the current location
of the mouse.  When you move the edge of an acceptance limit, the range will move accordingly.

Moving Acceptance Area: Using your mouse, right-click anywhere within the green acceptance
(or red failure) area.  You’ll see a cross.  While continuing to press the right mouse button you can drag the
whole acceptance area across the x-axis.  A small pink box displays the current location of the mouse.
Increase/decrease Amplitude Band: Using your mouse, right-click on the top or bottom edge of the green
acceptance (or red failure) area. You’ll see an up & down pointing arrow. While continuing to press the
right mouse button, you can drag the edge of the limits across the y-axis. A small pink box displays the
current location of the mouse.

Decrease Limit Range: Using your mouse, right-click on the edge of the expanded plot.  You’ll see a left
and right pointing arrow.  While continuing to press the right mouse button drag the edge of the plot across
the x-axis.  A small pink box displays the current location of the mouse.

Magnifying  Areas on Graph
X-axis: Hold down the Ctrl key while you click and drag the mouse across the area of interest.

Y-axis:  Hold down the Alt key while you click and drag the mouse across the area of interest.

Both axes:  Hold down the Ctrl and Alt keys while you click and drag the mouse around the area of
interest.
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File Menu

New Project
When you select New Project, the “Save As” window opens.  If you already have a project defined, it will
open to the folder where that project is saved.  You can create the new project here, or you can create a new
folder in which to save your project.

Save As Dialog

1. Select New Project on the File menu.
2. Find the folder in which to save this project, or create and name a new folder.
3. Type a file name (including the extension).
4. Click the <Save> button.

Open Project
The Open Project command, opens the “Open” window.

Open Project Dialog

1. Select Open Project on the File menu.
2. Find the folder in which your project was saved.
3. Click the <Open> button.

If you have an older EZ-NDT/RI project with multiple files (i.e., files with extensions “.ndt1”,
“.ndt2”, etc.), they will be combined into one file (with a “.ndt” extension) once the latest version of
the EZ-NDT/RI.exe is used to open the old “.ndt1” file.

Save Project
This menu item save the current state of your project.
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Save As...
This menu item opens the Save As window.  Enter a new path and file name for this project.  Use this
command to save setup time on a new project if it is very similar to a current or older project.

Save As Dialog

Start/Stop Acquisition
Use this command to start or to stop data acquisition.  You can also issue this command by pressing the F5
key.

Erase History File

Erase History File Prompt

�������

This menu item will PERMANENTLY erase all data stored in the history file.
You will be asked to confirm your action.  Once you have confirmed the Warning
message, there is no way to retrieve the data.

Print
The Print command prints the Main window.

Exit
Quits the NDT/RI application.  This can be performed only when the User level is Manager.
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Edit Menu

ZonicBook

This menu option is only available at Level 3 operation AND when Data Acquisition is
OFF.

The ZonicBook Configuration window includes four Tabs.  The “Channels” Tab allows you to define the
input channels.  The “Acquisition” Tab defines the data acquisition setup.  The “Limits” Tab allows you to
specify the acceptance criteria. The Automation Tab allows for output to the eZ-NDT/RI Automation
Module.  This window always opens with the channels tab active.

After you create a new eZ-NDT/RI Project, you may need to modify the configuration, select “ZonicBook”
on the Config. Menu. The ZonicBook Configuration window will open.

Normally the configuration settings defined during the feasibility study are used.
Please do not deviate from these unless you are an advanced technician.
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Acquisition Tab
Use this panel to configure the ZonicBook’s Acquisition parameters.

ZonicBook Configuration Acquisition Tab

Company: Enter your Company Name.  This label is displayed in the upper left portion of
the main graphics window and on all data reports.

Part Number:   Enter the Part Number for this eZ-NDT/RI Project.  This label is displayed in
the upper left portion of the main graphics window and on all data reports.

History File Size: Enter the desired History File Size.  The history file is a FIFO file.  This value is
the size of this file.  The total amount of required hard disk space for the
requested file size is displayed below the History File Size data entry box.
The amount of disk space required cannot exceed 2.1 gigabytes.
Data is stored to the history file after each NDT/RI analysis.

Block Size: Select the desired Block size.  This value is the number of samples per block of
data.  For example, a 2048 Block size contains 2048 data samples and will
produce an 800 line spectrum.  A larger Block size will provide you with greater
data resolution.  However, it takes longer to collect a block of data.

Analysis Frequency: Select the desired Analysis Frequency.  This value is the maximum frequency of
interest.  The sampling rate will be 2.56 times the analysis frequency.  Verify
the maximum frequency response of your probes.  Typically, the analysis
frequency will be 20 KHz. [Default:  20 KHz.]

Number of Averages: Select the desired Number of Averages.  This value is the number of data blocks
used in the NDT/RI analysis.  Typically, the number of averages is set to one.

y-Axis Scaling: Select either EU Amplitude or dB.
Calculate: The Calculation Mode determines whether Spectrum or FRF mode will be used.

FRF mode is generally preferred for getting data from multiple parts quickly;
Spectrum mode should be used for small numbers of parts, or slower
acquisitions.

Number of Flashes: The number of times the results of each test will flash on the screen.
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Channels Tab
Use this panel to configure each input signal for your project. Set the values for each channel attribute.
Repeat for each channel.

Double click in a cell to edit its value.  Use the scroll bar to view the entire table. You can copy the
attributes of one channel to another by holding down  the Shift Key and clicking the desired channel.

ZonicBook Configuration Channels Tab

No.: Select the Channel button representing the  channel you are setting up.
Type: Select the instrument Type on the pull down menu.  Types include Force, Response, and

Unused.   You must have 1 Force Channel and 1 or more Response Channels.
[Default:  Channel 1 is the Force channel; channel 2 is the Response channel;
channels 3 through 8 are unused.]

Configure the Dip Switches located under the ZonicBook Input Module for each probe.
Typically, Hammers, Microphones, and Accelerometers are Single Ended,
AC Coupled, and ICP On.

Name: Enter a Name label for the channel.  Something as simple as Trigger or Response is
okay.

Min/Max/Units
(Range):

Enter the instrument Minimum in engineering units, the instrument Maximum in
engineering units, and the engineering Units for the channel.
[Default:  Force Units are lbf (pounds force) for modal hammers; G’s for
accelerometers; and Pa for microphones.]

Full Scale
Voltage:

Select the maximum Full Scale Voltage expected for the instrument.  Erroneous results
will occur if you select a voltage value that is less than the actual input voltage.

mV/Unit
(Sensitivity):

Enter the instrument’s input Sensitivity.  Typical accelerometers have a sensitivity of
100 mV per g; microphones have 25 mV per Pa; and hammers have 1 mV per lbf.
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Trigger Level
Percentage:

This value is the percentage of the full scale voltage at which the force (hammer)
signal must reach before it is recognized as a trigger event.  Each trigger event results
in a test inspection.  For example, if the FSV for the instrument is 1.000 V and the
Trigger Percentage is 10%, eZ-NDT/RI will trigger acquisition when the
Force Input is 0.100 V.

Pre / Post
Trigger
Percentage:

This value defines the start of the data block as a percentage of the block size from -
100% to +100 %.  A negative value will result in a Pre Trigger.  A positive value will
result in a Post Trigger.  For example, if the value entered is “-10”, a Pre Trigger of
10% of the block size is defined.  10 percent of the data block occurred prior to the
trigger event. For most applications, a Post Trigger is recommended.  (+10.)

FFT Window: All measurements using the FFT must take care to avoid potentially serious errors due
to the phenomenon known as “FFT leakage", in which a signal at one frequency
spreads out ("leaks") over a wider frequency range in the FFT spectrum. Intuitively,
leakage arises from cutting out a finite length "window" of data from a longer
continuous signal, causing an apparent discontinuity at the ends of the data block,
which has nothing to do with the actual signal. These "truncation" errors can be
effectively controlled, though not completely eliminated, by multiplying each data
frame by a suitable time-domain weighting-window that smoothly attenuates the data
near the ends of each block, prior to performing the FFT.
Select the desired FFT Window function for the input channel.  Your choices are
None, Hanning, Flat top, Exponential, and Force.

• None:  Do not apply a window function to the display.

• Hanning:  The Hanning window offers a reasonable trade-off of frequency
accuracy versus amplitude accuracy.

• Flat Top:  This window has a very low peak amplitude error, and its frequency
resolution is somewhat better.  Its side lobes are considerably higher.  Its
effective noise bandwidth is still almost twice that of the Hanning window,
therefore this window is used mainly to measure accurate peak amplitudes of
discrete spectral components that usually separated by at least several spectral
lines.

• Exponential:  An Exponential weight window is equal to 1.0 at the beginning of
the block and decays exponentially to a smaller value at the end of the block.
Exponential is used only with transient data that is captured with pre-trigger to
assure that the initial values in all data channels are very close to zero.
Exponential can be used with all transient excitation methods in order to force
the signals to decay close to zero, even if the block length is not sufficient to
capture all of the naturally occurring response.  If the data decays naturally to a
low amplitude within the block, so that leakage is not significant, exponential
windowing can improve the signal-to-noise ratio by giving reduced weight to
the very low-amplitude data at the end of the block.

• Force:  This is a rectangular function that helps to ensure a consistent force is
applied to each part.
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Channel Tabs- Edit Menu

Set Defaults: This menu item will  return the channel configuration to the values pre-set at the
factory.

Copy Channel: This menu item copies the configuration of a channel into memory.  Use the Paste
Channel the values to another channel.

Paste Channel: This menu item pastes to a select channel the configuration of a channel that was
previously copied with the Copy Channel menu item.

Fill Down: This menu item copies the highlighted cell down to all active cells below it.
Fill Up: This menu item copies the highlighted cell up to all active cells above it.

If the selected cell is a response channel and a force channel is above or below it, the
force channel configuration will be overwritten.

Zero All: This menu item clears the entire configuration grid.
Zero Row: This menu item clears the row in which a selected cell resides.  If no cell is selected,

the top row is cleared.
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Limits Tab
Use this panel to configure the limit criteria for each input signal.  You can define up to 10 limit ranges per
response channel.  Select the channel of interest; then define the range and limit values.  Repeat for each
range and response channel.  Copy attributes of one range to another using options on the Edit menu.

ZonicBook Limits Tab

No.: The Channel number.
Instrument: This is the response channel for which you will be setting limits.  Typically

there is only one Response Channel.
Bin: For each significant peak you wish to monitor there should be a bin with a

defined range and limits.
Range Low/High: Enter the upper and lower frequency range.  eZ-NDT/RI will find the

maximum peak within this frequency range.
Limit Low/High: Enter the upper and lower limits range.

For a green limit: if the frequency of the maximum spectral peak for the
frequency range is within the Limits range, the part passes.
For a red limit: if the frequency of the maximum spectral peak for the
frequency range is within the Limits range, the part fails.

Units: Select Frequency-(Hz) or Time-(sec) based limit checking.  Typically
Frequency is used.

Amplitude Low/High: Enter the upper and lower Amplitude Range.
For a green limit: if the amplitude of the maximum spectral peak for the
frequency range is within the amplitude range, the part passes.
For a red limit: if the amplitude of the maximum spectral peak for the
frequency range is within the amplitude range, the part fails.

Green/Red Defines whether the limit you are setting will be a green “pass” limit or a red
“fail” limit.
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Limits Tab - Edit Menu

Set Defaults: This command returns the channel configuration to the values pre-set at the factory.
Copy Channel: This command copies the configuration of a channel into memory.  Use the Paste

Channel command to paste the values to another channel.
Paste Channel: This command pastes to a select channel the configuration of a channel previously

copied with the Copy Channel menu item.
Fill Down: This command copies the highlighted cell to all active cell below.
Fill Up: This command copies the highlighted cell to all active cells above.

If the selected cell is a response channel and a force channel is above or below it, the
force channel configuration will be overwritten.

Zero All: This command clears the entire configuration grid.
Zero Row: This command clears the row in which a selected cell resides.  If no cell is selected, the

top row is cleared.
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Automation Tab

ZonicBook Automation Tab

Use this panel to configure the responses of your eZ-NDT/RI Automation Module.  This device will allow
you to have relay switches open and close based on the results of each test.  You can use up to four relays.

The color of the response channel indicates the pass (green)/fail (red) status of the part.  If the response
channel relay is normally open (green) when a part passes inspection the relay will remain open.  On the
other hand, if the response channel relay is normally open and a part fails, the relay will close for the
duration specified by the time; and then it will reopen.

Additionally, you can have the system count the number of consecutive fails and change the relay status
when a specified number of consecutive failures is reached.

Relays can be manually triggered in the Relay Output panel of the Main window by clicking on a
Relay Icon.

Communication Panel
The following conditions must be met for proper output of each device.

Device: The Output Relay module (currently 1).
COM Port: Select the COM Port that the output Relay module is connected to.

Relay Output Panel
Relay button: The number of the relay.  Up to 4 can be used.

Click on this button to activate or deactivate the relay.
Green = ON/activated, Red = OFF/deactivated.

  buttons: Sets the default state (normal operating state) of the relay.

 = Normally Open and  =  Normally Closed.
Timer: The amount of time required for a part to pass through the open gate.

When you click the <Save> button, any of the unchecked check boxes for relay channels
will close and stay closed until the condition is met for that relay channel.  If you have
something that will actuate when the channel closes, it will do so as soon as you click the
<Save> button.
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Response Channel State Panel
Shows the pass (green) / fail (red) status of the part when the relay switch is in its normal state.

Consecutive Panel
On/Off: Activates the “Consecutive Failures” counter.
Number: The number of consecutive failures required to change the relay status.

How Automation Relays work
When the result of the part is equal to the result indicated by the Response Channel button, the operating
state of the relay (indicated by the   buttons) changed and a signal is sent to the relay switch.

Conversely, when the result of the part does not equal the result indicated by the Response Channel button,
the state remains unchanged and no signal is sent to the relay switch.

Example of Automation Relay

Example Scenario:  You want all tested parts (good and bad) automatically sent on a conveyor to the next
process. Good parts go to finishing. Bad parts go to re-work.

In the event if there is any type of failure with the relay switch, you don’t want bad parts misdirected to
finishing.  Therefore you should set up the conveyor so that the gate for the good parts is closed and only
opens when a part passes.

This means that the relay switch is normally open (no current).  A good part activates the relay switch and
opens the gate.  A bad part does nothing to the relay and proceeds on to rework.  See the above diagram.

In the Automation Setup Panel, you would make the following choices.

Relay:  Green

  buttons:  , Normally Open

Response Channel:  2

Timer:  (Amount of time required for a part to pass through the open gate.)

Reset Summary Counts
Resets the summary count to zero.  This has no effect on the history file.

Copy Window
This option copies the current window so it can be pasted into another application such as Microsoft Word
or Excel.
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Load Graphic Picture
When documentation is required for your project a picture of the part being tested is useful.  If you have a
picture of your part, select this command to place it in the upper right corner of the main window.

Remove Graphic Picture
This command removes the graphic from the main window.  This is only active if a graphic has been
loaded.



ZonicBook 10-30-01 eZ-NDT/RI, pg.  35

Report Menu
eZ-NDT/RI generates four reports.

Generate a Production Report
The Production report contains the overall NDT inspection results for the specified time period. To
generate a Production report:

eZ-NDT Production Report Dialog

1. Select Production... on the Report menu.

2. The production report dialog is displayed.

3. Select whether you would like to generate a Summary or Detailed production report by clicking on
the appropriate radio button.

4. Select the number of records to be included in your report by dragging the arrows up/down the scale.

5. Press the Okay button.

6. A save file dialog box will open.

7. Type a name your report file in the filename data entry box. Use a unique name for each report.

8. Click the Save button.

After generating the report, eZ-NDT/RI automatically opens the text file in Windows NotePad or WordPad.
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Summary...
The Summary Report contains the overall NDT/RI inspection results for the specified time period.
Statistical information is shown at the bottom of the report.  The serial number and inspector name are also
listed.

eZ-NDT/RI v.5.0.43
Project Path:     C:\PROGRAM FILES\ZONIC\EZ-NDT\ndt
Summary Report:   25-Oct-2001 08:57:03
Requested Range:  25-Oct-2001 08:50:01  -  25-Oct-2001 08:54:20

Company Name:     Your Company Name
Part No.:         Your P/N...

25-Oct-2001 08:50:01   FAILED
25-Oct-2001 08:50:05   FAILED
25-Oct-2001 08:50:10   FAILED
25-Oct-2001 08:53:10   FAILED
25-Oct-2001 08:53:11   FAILED
25-Oct-2001 08:53:13   FAILED
25-Oct-2001 08:53:14   FAILED
25-Oct-2001 08:53:15   FAILED
25-Oct-2001 08:53:18   FAILED
25-Oct-2001 08:53:35   FAILED
25-Oct-2001 08:53:36   FAILED
25-Oct-2001 08:53:39   FAILED
25-Oct-2001 08:53:44   FAILED
25-Oct-2001 08:53:48   FAILED
25-Oct-2001 08:53:52   FAILED
25-Oct-2001 08:53:54   FAILED
25-Oct-2001 08:54:04   FAILED
25-Oct-2001 08:54:06   FAILED
25-Oct-2001 08:54:18   FAILED
25-Oct-2001 08:54:20   FAILED

TOTAL PASSED:        0
AVERAGE PASSED:        0.00%
STD DEV PASSED:

TOTAL FAILED:        20
AVERAGE FAILED:      100.00%
STD DEV FAILED:

TOTAL:               20
AVERAGE TOTAL:       100%
STD DEV TOTAL:

eZ-NDT/RI Summary Report
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Detailed...
The Detailed Report, in addition to the information contained in the summary report, provides the measured
frequency and amplitude peak for each spectral band for each response channel.

eZ-NDT/RI v.5.0.43
Project Path:     C:\PROGRAM FILES\ZONIC\EZ-NDT\ndt
Detailed Report:  25-Oct-2001 08:56:43
Requested Range:  25-Oct-2001 08:50:01  -  25-Oct-2001 08:54:20

Company Name:     Your Company Name
Part No.:         Your P/N...

25-Oct-2001 08:50:01   FAILED  Ch 02   F  1031.3  .00018   F  4056.3  .00006   F  7818.8  .00005   F
10044.  .00003
25-Oct-2001 08:50:05   FAILED  Ch 02   F  1231.3  .00019   F  4481.3  .00005   F  8131.3  .00004   F
12181.  .00003
25-Oct-2001 08:50:10   FAILED  Ch 02   F  1231.3  .00018   F  4556.3  .00006   F  8975.0  .00004   F
10806.  .00004
25-Oct-2001 08:53:10   FAILED  Ch 02   F  1625.0  .00017   F  4700.0  .00006   F  7443.8  .00004   F
10688.  .00003
25-Oct-2001 08:53:11   FAILED  Ch 02   F  1131.3  .00018   F  5018.8  .00005   F  7450.0  .00004   F
12125.  .00003
25-Oct-2001 08:53:13   FAILED  Ch 02   F  1231.3  .00020   F  4381.3  .00006  P   8243.8  .00005   F
10531.  .00004
25-Oct-2001 08:53:14   FAILED  Ch 02   F  1231.3  .00015   F  4037.5  .00006   F  9268.8  .00004  P
11375.  .00004
25-Oct-2001 08:53:15   FAILED  Ch 02   F  1231.3  .00015   F  4318.8  .00005   F  8025.0  .00004   F
10463.  .00004
25-Oct-2001 08:53:18   FAILED  Ch 02   F  1131.3  .00018  P   5250.0  .00005   F  9256.3  .00004   F
10769.  .00004
25-Oct-2001 08:53:35   FAILED  Ch 02   F  1231.3  .00016   F  4481.3  .00006   F  8056.3  .00005   F
10119.  .00004
25-Oct-2001 08:53:36   FAILED  Ch 02   F  1231.3  .00018   F  4006.3  .00006   F  7137.5  .00004   F
10350.  .00003
25-Oct-2001 08:53:39   FAILED  Ch 02   F  1231.3  .00018   F  4318.8  .00005   F  9987.5  .00004   F
10794.  .00004
25-Oct-2001 08:53:44   FAILED  Ch 02   F  1131.3  .00019   F  4481.3  .00006   F  8987.5  .00004   F
10119.  .00003
25-Oct-2001 08:53:48   FAILED  Ch 02   F  1231.3  .00018   F  4981.3  .00006   F  7381.3  .00005   F
10756.  .00005
25-Oct-2001 08:53:52   FAILED  Ch 02   F  1131.3  .00018  P   5550.0  .00005   F  7493.8  .00004  P
11644.  .00003
25-Oct-2001 08:53:54   FAILED  Ch 02   F  1231.3  .00018   F  4381.3  .00006   F  7043.8  .00004   F
12156.  .00004
25-Oct-2001 08:54:04   FAILED  Ch 02   F  1231.3  .00018   F  4718.8  .00005   F  7018.8  .00005   F
11094.  .00004
25-Oct-2001 08:54:06   FAILED  Ch 02   F  1231.3  .00017   F  4306.3  .00004   F  7350.0  .00004   F
11094.  .00004
25-Oct-2001 08:54:18   FAILED  Ch 02   F  1231.3  .00017   F  4381.3  .00006   F  9600.0  .00004   F
9987.5  .00003
25-Oct-2001 08:54:20   FAILED  Ch 02   F  1231.3  .00017   F  4381.3  .00006   F  7112.5  .00004   F
12006.  .00003

TOTAL PASSED:        0         Ch 02  0                   2                   1                   2
AVERAGE PASSED:        0.00%   Ch 02        0.00    0.00      5400.0  .00005      8243.8  .00005
11509.  .00003
STD DEV PASSED:                Ch 02        0.00    0.00      150.00  11.1E-07        0.00    0.00
134.38  25.6E-07

TOTAL FAILED:        20        Ch 02  20                  18                  19                  18
AVERAGE FAILED:      100.00%   Ch 02      1220.9  .00018      4443.8  .00006      8080.9  .00004
10893.  .00004
STD DEV FAILED:                Ch 02      107.91  .00001      273.87  59.9E-07      935.71  35.7E-07
727.93  45.1E-07

TOTAL:               20        Ch 02  20                  20                  20                  20
AVERAGE TOTAL:       100%      Ch 02      1220.9  .00018      4539.4  .00005      8089.1  .00004
10955.  .00004
STD DEV TOTAL:                 Ch 02      107.91  .00001      389.94  62.0E-07      912.71  35.7E-07
716.14  43.8E-07

eZ-NDT/RI Detailed Report
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Plot Data…
The Plot Data report generates a list of all the data points (using x and y coordinates) that are displayed on
the graph. To generate a Plot Data report:

1. Select Plot Data... on the Report menu.

2. A save file dialog box will open.

3. Type a name your report file in the filename data entry box. Use a unique name for each report.

4. Click the Save button.
After generating the report, eZ-NDT/RI automatically opens the text file in Windows NotePad or WordPad.

Configuration...
The Configuration Report is a comprehensive listing of the project’s parameters.  It is a text file that can be
saved and included with project documentation.

1. Select Configuration Settings... on the Report menu.

2. A save dialog will open.

3. Type a name your report file in the filename data entry box. Use a unique name for each report.

4. Click the Save button.

After it is generated, eZ-NDT/RI will automatically open the report using Windows NotePad or WordPad.
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User Menu

Enter Password
Enter a Password for Level 3 (Manager).  This password allows you to “password protect” your NDT/RI
project.

Enter Password Dialog

Change Password

Edit Password Dialog

Change User Levels

Remember your Level 3 password.  If you go to Level 1 (Inspector), you will need the
password to return to Level 3 (Manager).

The current User Level is displayed in the lower portion of the Acquisition panel.  There are 3 User Levels.
Level 3 (Manager) allows you complete access to all eZ-NDT/RI features.  Level 1 (Inspector) enables
minimal features.  Typically you would use this feature if you have concerns regarding unauthorized access
to your eZ-NDT/RI Projects while the system is unattended.  Use the User pull down menu to modify the
security access level and Level 3 password.

Help Menu

What’s This Help
When you use this menu item, your cursor changes to a question mark, “?.”  Click on an eZ-NDT/RI panel
or screen with this cursor for a brief explanation of the selected item.

About
This menu item tells you the version of eZ-NDT/RI you are running, and your system configuration.
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Additional Notes
Here is a list of common suggestions for you to use eZ-NDT/RI more effectively.

1. It will save you time, if you modify the NDT/RI project in the executable’s directory to match your
standard configuration.  Whenever you create a New Project, this project is the configuration
template that is copied into your new project.

2. Make sure your ZonicBook Dip Switches are configured correctly.
(Typically:  Single Ended, AC coupled, and ICP ON.)

3. Use a standard channel location convention for your Force and Response channels.
(Typically:  Force is channel 1 and Response is channel 2.)

4. If you aren’t getting a Trigger after you strike the part, verify the Force channel’s FSV and
Trigger Level Percentage.

5. A negative Pre / Post Trigger percentage will result in FRF calculations and limit checking.  A
positive Pre / Post Trigger percentage will use auto spectrum.  Generally, you should use a positive
Pre / Post Trigger percentage.

6. Some older versions of eZ-NDT/RI created multiple project files (i.e., files with extensions “.ndt1”,
“.ndt2”, etc.). If you wish to open an older file with newer versions of eZ-NDT/RI which use only
one file, simply open the old “.ndt1” file. This old project will automatically be converted to a single
file with a “.ndt” extension.

7. If for some reason, you have an error where eZ-NDT/RI does not start.  You can work around
the problem by deleting the file, “ndt.ini,” located in the executable’s directory.  This file identifies
the last Project opened.  You can delete this file without affecting your data.  Try reopening the last
project.

8. If you still experience problems.  Please send an email to productsupport@iotech.com.

mailto:productSupport@iotech.com
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 Setting Limits 5
Limits are defined frequency and amplitude ranges (where the resonances of a part will peak) across the
x-axis.  In our example, we impacted several known good parts and captured a sample resonance in the
following display.  We then placed cursors at the peaks we thought were significant.  These same peaks
may change in amplitude or shift frequency if a part is bad.  Please note that significant peaks are not
always the ones with the most amplitude.  In fact, some of the peaks at lower amplitudes can be very
significant because when they are below a certain amplitude it indicates that the part is “bad.”

Significant Peaks

Now that we know where the peaks are located, we can set the limit range in which they will appear.

Use the cursor values listed to the right of the plot to help you determine where frequency and
limit ranges should be set.

Note that the first cursor is at 4250 and that there is another peak at approximately 4800, which we did not
mark with a cursor.  However, if a part is bad, that peak may shift down in frequency.  Therefore, when
setting our “good” limit, we must make sure that we set it low enough so that the resonance shift of the
“bad” peak doesn’t create a peak within our “good” limits.

In our example we set the frequency range from 4050 to 4450 and the frequency limits between 4150 and
4350.  Remember our “good” peak should be around 4250.

Setting Limits using Significant Peaks
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